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About this Manual 
 

This manual describes the SC28 Monitor for Magnetic Fields, Vibrations, 
Acoustics, Temperature and Humidity and explains how to use it. 
 

Organisation of this Manual 
 
Chapter 1 - Introduction to the SC28 System, describes the system components and 
applications. It explains how to get started, how to use the sensors, how to run the 
programs and how to get help. 
 
Chapter 2 – Environmental Disturbances, describes the environmental factors that 
can disturb an electron beam instrument. 
 
Chapter 3 – Setting up Monitoring, explains how to use the electron beam 
instrument’s environmental specifications to guide the setting of the SC28 controls.  
 
Chapter 4 – Signals and Scales, is a detailed reference on the SC28 signals and 
scales settings. 
 
Chapter 5 – Spectrum Analyser Controls, is a detailed reference on the SC28 
spectrum analyser settings. 
 
Chapter 6 – Chart Recorder Controls, is a detailed reference on the SC28 chart 
recorder settings. 
 
Chapter 7 – Data Logging Controls, is a detailed reference on the SC28 
datalogging settings. 
 
Chapter 8 – Environmental Specifications, explains how to load a microscope’s 
environmental specifications into the SC28 for direct comparison with measured 
results. 
 
Chapter 9 – SC28 Calibration, explains how to load calibration files, reset a DC 
sensor, self-check a microphone and add user-defined units. 
 
Chapter 10 - Menu and Toolbar functions, explains how to use all the Menu and 
Toolbar functions of the SC28. 
 
Appendices 1-4 give details of SC28 specifications, file formats, units and window 
functions. 
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Conventions used in this Manual 
 
The following conventions are used in this manual: 
 
bold  Bold text denotes control names, menu items, dialog box buttons or  
  options that appear on the screen. 
 
italic  Italic text denotes emphasis, a cross reference, or an introduction to  
  a key concept. 
 
bold italic Bold italic text denotes a note, caution, or warning. 
 
< >  Angle brackets enclose the name of a key on the keyboard. 
 
+  A plus between two or more key names enclosed in angle  
  brackets denotes that you hold down the first key while you press  
  the next key(s) - for example, <ctrl+P>. 
 
 Warning: This symbol to the left of bold italic text denotes a warning,  
  which alerts you to the possibility of damage to your equipment. 
 
! Caution: This symbol to the left of bold italic text denotes a caution, which  
  alerts you to the possibility of data loss or a system crash. 
 
 Note: This symbol to the left of bold italic text denotes a note, which  
  alerts you to important information.  
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Chapter 1 - Introduction to the SC28 System 
 
Hardware 
 

The SC28 monitor is a designed for long term monitoring of the room environment 
for electron microscopes and similar equipment. It can log the spectra and charts of 
ambient magnetic fields, vibrations, acoustic levels, temperature and relative 
humidity. It measures the magnetic fields, vibrations and acoustic levels at 2 kHz 
and temperature/humidity at 1Hz or below. Measurements are taken continuously, 
with no gaps, so that no event is missed. It supports the following hardware: 
 

Model Number of Inputs  
3-axis 
Magnetic Field 

Vibration Precision 
Microphone 

Temperature/ 
Humidity 

AUX 
BNC 

SC28/SI 1 3 1 1 1 
 
The SC28/SI supports a wired Ethernet connection. 
 

Software 
 
The SC28 software runs on a Windows PC that is connected to the same Local 
Area Network as the SC28/SI. It automatically detects the SC28/SI hardware 
without needing to know its IP address in advance. Included with the SC28 
software is the SCplot program, which views and prints results or saves graphs that 
you can use in reports. 
 

Sensors 
 
The following sensors are available for the SC28 system: 

Sensor Description 
Sensor 
SC11/AC 

A 3-axis AC magnetic field sensor with a lower bandwidth of 
1 Hz and a dynamic range of 80 mG (8 T) Pk-Pk. 

Sensor 
SC24/DC+AC 

A 3-axis DC magnetic field sensor using magneto-resisitive 
technology with a lower bandwidth down to DC a dynamic 
range of 40 mG (4 T) Pk-Pk. 

Wilcoxon  
731A 

A Seismic Accelerometer, with bandwidth of 0.1 Hz to 500 Hz 
and max range of 200 mg’s (20 mm/s2) Pk-Pk in this system. 

B&K 
4190/2669L 

A Brüel and Kjær precision microphone type 4190 with 
preamplifier type 2669L can measure from 20 dB to 100 dB 
with a lower bandwidth of 1.5 Hz. 

SC28/TH A combined Temperature and Relative Humidity Sensor. 
AUX One input is available for a user-defined channel as required. 
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Connecting the SC28/SI 
 
Connect an Ethernet cable from the sensor interface to the Local Area Network 
(LAN) that your PC is connected to. (If there is no LAN, you may connect the PC 
and SC28/SI together directly. In this case, both devices should use a link local IP 
address of the form 169.254.x.x). Connect the supplied power supply to the DC IN 
input and to an AC outlet of 100-240V, 50-60Hz.  
 
When you run the SC28 software, it automatically detects the SC28/SI hardware 
and connects to it. If no SC28/SI is detected the software will wait until one is 
connected to the LAN. If more than one SC28/SI is detected on the LAN, the 
software asks which you wish to connect to. Once connected, the SC28/SI’s serial 
number is automatically selected on the Calibration panel.  
 

Connecting a 3-axis Magnetic Field Sensor 
 
Mount a Sensor SC11/AC or Sensor SC24/DC+AC magnetic field sensor onto 
the tripod provided and connect it to the MAG input. Select the serial number of 
the sensor on the Calibration panel. The magnetic field sensors have three axes, 
oriented as shown on the label. They display on the MX, MY and MZ channels in 
the SC28 Monitor. DC sensors must be reset after they are moved, using the 
software Reset DC button. 
 
 Note: Plug in the AC or DC sensor before you start the SC28 program, 

because the software detects the sensor at start up. 
 
Connecting Accelerometers 

 
Each accelerometer measures 1-axis vibration, oriented along the axis of its 
cylindrical case. It is supplied with a stand, allowing it to be placed on the floor in 
each of the X, Y and Z directions. 
 
On the SC28/SI there are three four-pin accelerometer connectors: VIBX, VIBY, 
VIBZ. They display on the VX, VY and VZ channels in the SC28 Monitor. 
 
Select the accelerometer(s) on the Calibration panel. You can connect or 
disconnect an accelerometer at any time. 
 
 Warning: Do not drop the accelerometers. They are fragile and must be 

handled gently. 

 Note: Allow 2 minutes for the DC operating level of an accelerometer to 
  stabilise after turning it on or moving it. Moving it more gently 

reduces the settling time. 
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Connecting a Precision Microphone 
 

Insert a Brüel and Kjær precision microphone type 4190 with preamplifier type 
2669L into one of the holders on the tripod provided and gently tighten the holding 
screw. Connect the cable to the MIC input of the SC28/SI. 
 
Select the microphone’s serial number on the Calibration panel. The signal then 
displays on the A channel in the SC28 Monitor. 
 
You can run a quick self-check on the microphone from the Calibration panel. See 
the Microphone Self Check  section of Chapter 9 – Calibration for details. 
 
 Warning: Do not drop the microphone. It is fragile and must be handled 

gently 
 
Connecting a Temperature/Humidity Sensor 
 

Insert a Sensor SC28/TH Temperature/Humidity sensor into one of the holders on 
the tripod provided and gently tighten the holding screw. Connect the cable to the 
TEMP/RH input of the SC28/SI. 
 
Select the sensors serial number on the Calibration panel. The signals then display 
on the T and H channels in the SC28 Monitor. 
 

Connecting a Voltage Signal (or User-defined Sensor) 
 
Connect the signal to the BNC AUX input. This input displays on the U channel of 
the SC28 Monitor. 
 
You can connect or disconnect the BNC input at any time. See the User Defined 
Units section of Chapter 9 – Calibration for how to add user-defined units.

 Warning: Connecting a voltage greater than ±30V to the AUX input could 

damage it. 
 

Install the Software 
 
The SC28 system is provided without a PC. First install the software on your 
computer using the separate instructions in the release notes.  
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Adding Sensor Calibration Files 
 
At installation time, you are prompted to install the sensor calibration files. You 
can add them at any other time by clicking the Cal button in the Monitor window 
then using Add Sensors on the Calibration panel. For full details, see the Add 
Sensors section in Chapter 9 - Calibration. 
  

How to Run the Programs 
 
To run the SC28 programs, select one of the following from: 
Start Menu > All Programs > Spicer Consulting > SC28 1.0 > 

SC28 1.0 
SCplot 5.6 

 
SC28 is the main monitoring program that performs measurements and logs results 
to files on the PC.  
 

 
 
Click OpenMonitor to show the Monitor window that allows you to configure the 
settings and view the current measurements. 
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SCplot is for viewing, formatting, printing and saving graphs of results from the 
virtual instruments. For full details see the SCPlot User Manual. 

 
Getting Started 
 

Start the SC28. The SC28 should start up in the task bar. Click the SC28 task bar 
icon to open the SC28 main window. The status should show Starting… and then 
Connected to SC28/SI with its serial number, firmware version and IP address. 
Click Open Monitor to show the user interface where you can change the settings 
and view the current measurements. When data log files have been written, use 
SCplot to view them. 
 

How to Exit SC28 
 

Close the SC28 Monitor window using the close button at the top right corner of 
the window. You may do this any time without affecting the data capture and 
logging function of the SC28 main window. If you have changed any settings, it 
will ask you to save the setup. When the SC28 starts up it automatically loads the 
setup file setup.sc28. Normally this is all that is needed. However, you can 
save the settings to a different file name if you need to keep alternative setups. 
 
To shut down data logging and close the whole program, click the Stop button on 
the SC28 main window. 
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Getting Help 
 
Help is available in the following ways: 
 

 Help <F1> 
 
• To get help, click the Help button or select Help for SC28 from the Help menu. 
 
• Tip strips appear when you move the pointer over the icons and sensor controls, 
providing additional information. 
 
• To turn on the help window, click on Show Context Help from the Help menu in 
any of the programs. When you move the cursor onto any control of the 
instrument, the help window shows information about that control. You can drag 
the help window to any location on the screen. To close the help window, click on 
its close button. Alternatively, you can use <ctrl-H> to toggle the help window on 
and off. 
 
• To see brief information about the program, click on About... from the Help 
menu. 
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Chapter 2 – Environmental Disturbances 
 
Electron Beam Instruments 

 
The SC28 Monitor is purposed-designed to monitor the environment for electron 
beam instruments, including Scanning Electron Microscopes (SEM), Transmission 
Electron Microscopes (TEM), Electron Beam Lithography tools and SEM-based 
metrology and inspection tools. These instruments are sensitive to magnetic fields, 
floor vibrations, acoustic levels, temperature and humidity. Manufacturers specify 
the maximum changes of these quantities that can be tolerated before movement of 
the electron beam prevents the instrument from reaching its optimum performance. 
The methods and units of the specifications vary between manufacturers, but the 
SC28 is flexible enough to measure the parameters found in all mainstream 
manufacturers’ specifications.  
 

Magnetic Field Sources 
 
Power Frequency (50 or 60 Hz) magnetic fields are often produced by current-
carrying power cables. Problem fields may come from well-installed cables 
carrying very large currents or from moderate but unintentional currents flowing in 
loops made by protective ground conductors and structural steel frames. 
Equipment such as lighting and air conditioning may make a field, but there are 
many examples of well-installed units that cause no problem at all. Power 
distribution panels and transformers make very local fields and may therefore 
cause severe difficulties if they are close, but none at all if they are distant. 
 
Slowly varying magnetic fields are often called DC fields. They require a DC 
sensor to measure them accurately. They may be produced by large ferromagnetic 
objects moving in the earth’s magnetic field, including nearby doors, road traffic 
and lifts/elevators.  
 
Electric trains, trams or trolley buses may make fields at DC, 16.67, 50 or 60 Hz 
depending on the power used. Much of the field comes from currents flowing in 
the overhead wires, tracks or associated wiring, rather than passing vehicles 
themselves. The field is usually vertical and may extend hundreds of metres away 
from the track. 
 
Some equipment associated with electron beam instruments makes local fields. 
These fields are not usually a problem for the instrument, but they may cause 
confusion if the sensor is placed near to them. 
 
Power frequency magnetic fields often cause regular fine “tearing” of an SEM 
image that makes small “teeth” in any vertical edges. Other things may cause the 
same effect are ground loop currents in the external cables or pipes supplying the 
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electron beam instrument, electrostatic hum on detectors or probes in the chamber 
or other microscope faults. Power frequency fields may simply blur a TEM image. 
They may cause peaks in electron energy analysers to broaden or even split into 
two. 
 
DC magnetic fields may make an SEM image look wavy or cause stitching errors 
in electron beam lithography. 
 

Vibration Sources 
 
Vibrations may be caused by a wide variety of sources. Random vibration sources 
include people walking by, lifts/elevators, road traffic, trains and ocean waves. 
Regular vibrations may be caused by rotating machinery, including rotary pumps 
associated with the electron beam instrument. Synchronous motors rotate at 
slightly below the power frequency. Transformers may vibrate at harmonics of the 
power frequency. 
 
The severity of the vibrations depends strongly on the construction of the building 
and floor. Often concrete blocks and other isolation structures are placed under 
electron beam instruments to reduce vibration. Vibrations tend to be broadband, 
but with peaks at resonant frequencies that are characteristic of the instrument and 
its environment.  
 
Random vibrations may cause “tearing” of an SEM image, similar to power 
frequency magnetic fields, but much less regular and with varying amplitude. 
 

Acoustic Sources 
 
Acoustic sound levels are pressure waves in the air. They may be made by a wide 
variety of sources, which are readily identified by ear. However, many audible 
sounds are not a problem, but some instruments, particularly TEMs, are affected by 
inaudible low-level infra-sound. Acoustic problems are often caused by air 
conditioning systems, which need to be carefully designed to avoid them. 
 
Acoustic levels may translate into vibrations of some part of the instrument, such 
as the specimen stage in a TEM. As a result, the effect on the image may look 
similar to that of vibration. 
 

Temperature 
 

Changes in room temperature can cause drift of the image as different parts of the 
microscope expand or contract slightly. Air conditioning systems must be designed 
to keep temperature changes below a specified limit. 
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Humidity 
 
For microscopes where the stage is cooled by liquid nitrogen, the humidity in the 
room must be kept low to avoid water from the air condensing and forming frost 
and ice.  
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Chapter 3 – Setting up Monitoring 
 
Setup Steps 

 
The following steps are needed to set up the SC28 to monitor the environment of 
an electron beam instrument: 
 
1. Check the Specifications 
2. Define Position and Orientation 
3. Set up Signals and Scales 
4. Set up Spectrum Analyser 
5. Set up Chart Recorder 
6. Set up Data logging 
 

Check the Specifications 
 
Manufacturers provide environmental specifications for their instruments. Some 
are very clear and precise, but others require interpretation. 
 
Magnetic fields are usually specified in mG or nT, but it is not always specified 
whether these are RMS, 0-Pk or Pk-Pk values. It is conservative to assume it 
means Pk-Pk. Sometimes a distinction is made between fields that are synchronous 
or asynchronous with the power frequency because the instrument is designed to 
tolerate higher levels of synchronous fields. All instruments are sensitive to DC 
fields, but they are not always specified. If in doubt, assume a similar level of 
sensitivity as to asynchronous fields. 
 
Vibrations are usually specified in the frequency domain for measurement by 
spectrum analyser, but in many different ways. They may use displacement, 
velocity or acceleration units, RMS or Pk-Pk. They may use well-defined power 
spectral density units or third octave spectra, which are independent of the number 
of points setting of the spectrum analyser. However, they may be specified in 
straight vibration units, in which case the number of points affects the results, but it 
may not be specified. If in doubt, a rule of thumb is to assume that there is one 
point per Hz. 
 
Acoustic levels are usually specified in third octave dB bands. Common sound 
level weightings are dBA for human hearing, which is less sensitive to low 
frequencies, and dBC which is much flatter. Unless otherwise specified, use the 
B&K microphone with dB units (un-weighted response. 
 
Temperatures may be specified in degrees Celsius (Centigrade) or Fahrenheit. 
Humidity is usually specified as percent relative humidity. 
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Specifications in the frequency domain may be entered into the Specification 
Editor and loaded into the spectrum for direct comparison with the measurements. 
 

Define Position and Orientation 
 
Fix your measurement location at convenient place near to the column of the 
electron beam instrument, preferably where the sensors will not be in the way 
during operation or maintenance of the instrument. Place the magnetic field sensor, 
microphone and temperature/humidity sensor on the tripod roughly mid height of 
the column. Measure the vibration on the floor at the same location. 
 
The conventional orientation is X left-to-right, Y front-to-back, Z upwards relative 
to the electron beam instrument. Make a plan of the room showing the position and 
orientation of the measurements.  

 
Set up Signals and Scales 

 
In the SC28 Monitor, select the signals you want to measure according to the 
microscope specifications and the sensors that you have available. Select the 
Scope/Spectrum/Chart view based on the way the specification is written and the 
way in which you want to analyse or present the results. Set the units and ranges to 
match the units and specified levels for each quantity in the microscope 
specifications. See Chapter 4 – Scales and Ranges for more details. 
 

Set up Spectrum Analyser 
 
The Spectrum controls set the Frequency Range, Number of points in the 
spectrum, the Window function, the Spectrum Mode and the Combine Mode.  
 
Where possible, be guided by the microscope specification. In the SC28, all the 
signals share the same spectrum analyser settings, so compromises may have to be 
made. The frequency range can be set to the largest required. The number of points 
can be set to give the minimum required point bandwidth. See Chapter 5 - 
Spectrum Analyser Controls for more details. 
 

Set up Chart Recorder 
 
The Chart controls set the size and Unit of the Time Step for the chart and the 
Lower and Upper bandwidths for each signal. 
 
Where possible, be guided by the microscope specification. The maximum upper 
bandwidth in the SC28 is 1 kHz. Bandwidths are also limited by the sensors in 
some cases. See Chapter 6 – Chart Recorder Controls for more details. 
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Set up Data Logging 
 

 Data Logging <F6> 
 
Click the Data Logging tool or select Data Logging from the File menu to open 
the Data Logging control panel. 
 
The SC28 provides two types of data logging files Chart and Spectrum. Each 
have their own folder, file name and file interval settings. In addition, the SC28 can 
automatically delete old log files to save disc space. See Chapter 7 - Data Logging 
Controls for more details. 
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Chapter 4 – Signals and Scales 
 

 
The SC28 provides 10 channels of data acquisition. In the SC28 Monitor, these 
signals may be displayed on 6 scales and in 3 display formats (Scope, Spectrum 
and Chart). Up to 14 different graphs may be displayed giving simultaneous 
display of the data as it is acquired. 
 

Scale Signal Display 
Scope Spectrum Chart 

M MX Magnetic X axis Mscope Mspectrum Mchart 
MY Magnetic Y axis 
MZ Magnetic Z axis 

V VX Vibration X axis Vscope Vspectrum Vchart 
VY Vibration Y axis 
VZ Vibration Z axis 

A A Acoustic Ascope Aspectrum Achart 
U U User defined Uscope Uspectrum Uchart 
T T Temperature - - Tchart 
H H Humidity - - Hchart 

 
Magnetic field signals MX, MY and MZ are displayed together on the M scale. 
Vibration signals VX, VY and VZ are displayed together on the V scale. 
Temperature T and humidity H appear only on charts because they change too 
slowly to display on the Scope and Spectrum graphs. 
 

Signal Display and Clipping 
 
The Display tick boxes affect which signals and graphs are on display. The Signal 
Display tick boxes also control which signals are data logged. The Scope, 
Spectrum and Chart Display tick boxes do not affect data logging. 
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The Spectrum and Chart graphs are controlled by the Spectrum and Chart 
controls. The Scope graphs do not have their own controls – they are controlled by 
the Spectrum settings. The graph area re-formats depending on the settings of the 
Display tick boxes.  
 
The Clip indicators show when the incoming signals exceed the analog to digital 
converter range. If this happens on any channel selected for Display, the program 
turns on the Clip light for that channel. This warns you that data for that channel 
will show waveform limiting, harmonic distortion and inaccurate RMS and Pk-Pk 
levels. 
 
The following can cause clipping to occur: 
• Moving any magnetic field sensor in the Earth's magnetic field 
• Placing an SC11/AC sensor in an AC magnetic field greater than 80 mG pk-pk. 
• Placing a SC24/DC+AC sensor in an AC field greater than 40 mG pk-pk or 
where the DC level fluctuates more than ±20 mG after reset. 
• Connecting a voltage greater than 10V to the AUX input. 
• Moving an accelerometer or turning it over. Wait 2 minutes for it to recover. 
• Placing an accelerometer where it vibrates at greater than 200 mg's peak to peak. 
• Using a precision microphone at sound levels more than 103 dB. 
• It is not likely to find temperature or humidity out of range of the sensor. 
 

Scales and Ranges 
 
The SC28 provides unit and range settings for each scale. The User scale has a 
selectable sensor, depending on the user defined units available. 
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The SC28 provides the following units and ranges by default. User-defined units 
may be added. See the User Defined Units section of Chapter 9 – Calibration for 
how to add user-defined units. 
 

SC28 Amplitude Ranges 
Scale Sensor Unit Ranges 
M Magnetic mG milliGauss 1, 2, 5, 10, 20, 50, 100, 200, 500 

nT nanoTesla 1, 2, 5, 10, 20, 50, 100, 200, 500 
uT microTesla 1, 2, 5, 10, 20, 50, 100, 200, 500 
mA/m milliAmp 

per metre 
1, 2, 5, 10, 20, 50, 100, 200, 500 

A/m Amp per 
metre 

1, 2, 5, 10, 20, 50, 100, 200, 500 

V Vibration ug’s micro g’s * 1, 2, 5, 10, 20, 50, 100, 200, 500 
mg’s milli g’s * 1, 2, 5, 10, 20, 50, 100, 200, 500 
um/s2 micron per 

second 
squared 

1, 2, 5, 10, 20, 50, 100, 200, 500 

mm/s2 millimetre 
per second 
squared 

1, 2, 5, 10, 20, 50, 100, 200, 500 

um/s micron per 
second 

1, 2, 5, 10, 20, 50, 100, 200, 500 

mm/s millimetre 
per second 

1, 2, 5, 10, 20, 50, 100, 200, 500 

nm nanometre 1, 2, 5, 10, 20, 50, 100, 200, 500 
um micron 1, 2, 5, 10, 20, 50, 100, 200, 500 

A Acoustic mPa milliPascal 1, 2, 5, 10, 20, 50, 100, 200, 500 
Pa Pascal 1, 2, 5, 10, 20, 50, 100, 200, 500 
dB‡ decibel (no 

weighting) 
50, 60, 70, 80, 90, 100, 110, 120 

U Voltage mV milliVolt 1, 2, 5, 10, 20, 50, 100, 200, 500 
V Volt 1, 2, 5, 10, 20, 50, 100, 200, 500 

T Temperature C Degrees 
Celcius 

30, 40, 50, 60, 70, 80, 90, 100 

  F Degrees 
Fahrenheit 

60, 80, 100, 120, 140, 160, 180, 
200 

H Humidity %RH Percent 
relative 
humidity 

30, 40, 50, 60, 70, 80, 90, 100 

* g is the acceleration due to gravity. 
‡ dB units force the Chart Mode to be RMS 
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Integrating Units 
 
Velocity (um/s, mm/s) and displacement (nm, um) units require integration of the 
acceleration spectrum. The spectrum analyser integrates the acceleration spectrum 
by dividing it by  to get velocity and by  to get displacement, where  = 2f 
and f is the frequency. The chart recorder has filters to perform the integration, but 
the scope display always uses acceleration units for accelerometers. See Appendix 
3 - Units for more details of integrating units. The integration process boosts the 
low frequency end of the velocity and displacement spectra, making it easy to see 
the noise floor of the accelerometer at low frequencies.  
 
Decibel Units 
 
Acoustic decibel units (dB) are logarithmic units, requiring different ranges from 
other units. The Scope display uses Pa for dB units. See Appendix 3 - Units for 
more details of dB units. When you select dB units the Acoustic spectrum is forced 
to be RMS even if the Spectrum Mode is set to 0-Pk or Pk-Pk. The Chart mode for 
Acoustic is always set to RMS. 
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Chapter 5 – Spectrum Analyser Controls 
 

The Spectrum controls set the Frequency Range and Number of points in the 
spectrum, the Window function, the Spectrum Mode and the Combine Mode.  
 

 
 
Frequency Range 

 
The frequency range sets the upper frequency on display. 
 

Spectrum Frequency Ranges 
Unit Ranges 
Hz Hertz 25, 50, 100, 250, 500, 1000 

 
Number of Points 

 
The available numbers of points in the spectrum are as follows: 
 

Spectrum Number of Points 
250, 500, 1000, 2000, 4000 

 
The Frequency Range and Number of points affect (1) the frequency resolution, 
(2) the sweep time, and (3) the noise level.  
 
1. If you increase the number of points, you can distinguish frequency peaks more 
clearly, because this reduces the frequency step between points is f. f is simply 
the frequency range fr divided by the number of points n. 
 

f = fr / n 
 
2. The sweep time is the time taken to acquire one scope waveform, which is then 
converted into a spectrum. The sweep time is the reciprocal of the frequency step, 
and so can be found by dividing the number of points by the frequency range: 
 

ts = 1 / f = n / fr 
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Therefore, it increases in proportion to the number of points. The shortest available 
time is 0.25 s for 1000 Hz and 250 points and the longest is 160 s for 25 Hz and 
4000 points. You can see the length of the time sample from the Scope displays.  

3. Johnson noise is proportional to the square root of the frequency step, so it 
reduces as you increase the number of points. 
 

Vnoise f   ( fr / n) 
 
This affects measurements that contain wide-band noise, such as vibration. If you 
increase the number of points, the vibration spectrum reduces, because there is 
reduced signal in each point. Therefore, it is important to set the correct number of 
points when making comparisons with specifications. See below for third octave 
and power spectral density measurements, which do not suffer from this effect. 

 
Window Function 

 
The Spectrum Analyser uses a Discrete Fourier Transform (DFT) algorithm to 
calculate the spectra of captured waveforms. You can apply a Window function to 
the waveforms of all channels before the DFT is calculated. The following 
windows are available: None, Hanning or Flat top. The windows apply the 
transformations found in Appendix 4 – Window Functions  
 
Selecting None applies no window, but is not generally recommended, because of 
the spectral leakage that occurs when an incomplete number of cycles of the 
waveform are input to the DFT algorithm. This creates a broad skirt around each 
large peak in the spectrum. 
 
The Hanning Window is a general-purpose window to reduce the spectral 
leakage. It may allow you to see small amplitude frequency components that are 
otherwise hidden by the broad skirts around large peaks. However, it broadens 
each narrow peak from one point to three points wide. 
 
The Flat Top Window is for accurate measurement of the height of individual 
peaks. It broadens each narrow peak from one point to five points, but the height of 
the peak is accurate, even if the true peak falls mid-way between two points of the 
spectrum. 
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Spectrum Mode 
 
Using the Spectrum Mode control, you can select one of the following modes: 
 
Spectrum RMS, Spectrum 0-Pk and Spectrum Pk-Pk display the magnitudes of 
the component sine waves that make up the captured signal. They are scaled as the 
root mean square, amplitude or peak to peak of these component sine waves, 
respectively. 
 
Spectrum PSD displays the RMS power spectral density in amplitude units per 
root Hertz. In this mode the level is divided by f, the square root of the 
frequency step between points. This produces a detailed spectrum in which the 
level of wide band signals is independent of f. 
 
Third Octave RMS, Third Octave 0-Pk and Third Octave Pk-Pk display the 
spectrum in Third Octave bands on a logarithmic frequency axis. The frequency 
range sets the frequency of the upper band. The number of points in the spectrum 
determines the number of bands and hence the frequency of the lowest band. The 
frequency axis is logarithmic in these modes and the spectrum is stepped to show 
the third octave bands. 
 

Third Octave Frequency Bands (Hz) repeated in decades 
1 1.25 1.6 2 2.5 3.15 4 5 6.3 8 

 
Number of Bands depends on Number of Points 
Points 250 500 1000 2000 4000 
Bands 19 22 25 28 31 

The RMS level of each band is constructed by summing the squares of the 
magnitudes of the spectrum points within the frequency limits of the band. The 0-
Pk and Pk-Pk values are 2 and 22 times the RMS value respectively. Use the 
Hanning window for the most accurate results. There is a certain amount of 
overlap between the lowest frequency bands because they are derived from very 
few DFT points. With the Hanning window, the lower 4 bands may share up to 
33% of their energy with the two adjacent bands. This effect is less than 1% 
between all other bands. 

 
Combine Mode 
 

The Combine Mode controls how the Spectrum Analyser combines spectra from 
multiple acquisitions. Average mode computes the mean of the acquired spectra, 
in order to reduce noise levels. On a log scale, you can watch the noise reducing as 
each successive spectrum is included in the average. Peak mode keeps the largest 
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value seen at each point on the spectra, in order to hold the peaks of any unusually 
high activity.  
 
The Combine Mode function operates on the spectra acquired during the capture 
period of the Spectrum data log file. The total number of spectra combined is the 
Spectrum log file duration divided by the Spectrum Analyser period. If clipping 
occurs while combining, the clipped results are included. The clip light indicates 
that the results may not be accurate. Clipping information is included in the log 
file. 
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Chapter 6 – Chart Recorder Controls 
 

 
The Chart controls set the size and Unit of the Time Step for the chart and the 
Lower and Upper bandwidths for each signal. 
 

 
 

Chart Time Step 
 
The following time steps between chart points are available. Setting this is a 
compromise between the time resolution and the size of the data files produced. 
 

Chart Time Steps 
Unit Ranges 
s second 1, 2, 3, 4, 5, 6, 10, 12, 15, 20, 30 
min minute 1, 2, 3, 4, 5, 6, 10, 12, 15, 20, 30 

 
In the SC28 Monitor, the maximum chart length is 3600 points, so it is always at 
least 1 hour. The chart display normally shows the current chart data log file as it is 
being built up. However, it is possible to set data log file intervals so that only 
some of the file can be shown in 3600 points. In this case, once the chart is full, the 
oldest data on the chart is discarded as new data is acquired. This does not affect 
the data logged to the file. 
 

Chart Mode Controls 
 
You can select from 3 different Chart Modes for each Scale. The Lower and 
Upper Bandwidth controls set the 3dB frequency ranges that contribute to the 
display. The bandwidths available depend on the data acquisition hardware, the 
number of channels, the Sensor, Unit and Chart Mode. The limits are 
summarised in the table below: 
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Chart Recorder Bandwidth Limits 
Software Minimum (Hz) Maximum (Hz) 
SC28 1.0 0 1000 
Sensor Bandwidths   
Magnetic SC11/AC 1* - 

SC24/DC+AC - - 
Vibration Wilcoxon 731A 0.1 500 
Acoustic B&K 4190/2669L 1.5 - 
Voltage BNC input - - 
Temperature SC11/TH - 1 
Humidity SC11/TH - 1 
Integrating Units   
um/s, mm/s, nm, um 1 - 
Chart Mode   
RMS, Pk-Pk 0.2 - 

* 0.1 Hz in Waveform mode, using extended low frequency filter 
 
Where more than one limit applies, the strictest one is used. These values then 
affect what you can set in the bandwidth controls: 
 

Control Minimum Setting Maximum Setting 
Lower Bandwidth Minimum Maximum/2 
Upper Bandwidth Minimum*2 Maximum 

 
In addition, you cannot set the Lower Bandwidth higher than the Upper 
Bandwidth. 
 
! Caution: The chart recorder automatically limits the Bandwidth controls to 

available values when you change the Sensor, Unit or Chart Mode. 
Set these before adjusting the Bandwidths. 

 
Chart Waveform mode 
 
This mode charts the waveform directly. Each trace shows the mean of the 
maximum and minimum value of the signal that was seen during the time step for 
each point. 
 
Displacement and velocity waveforms 
 
It is sometimes useful to chart position or velocity. The chart recorder provides this 
feature by integrating the accelerometer signal. This sets the lower 3dB Bandwidth 
to 1 Hz. 
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The displacement and velocity waveforms are derived from an integrating filter 
with a sharp cut-off below 0.7 Hz. The sharp cut-off is necessary to reduce 1/f 
noise from the accelerometer, but it causes the filter to have the step response 
shown below. This means that you need to take care in interpreting the results. If 
you see this response, then discount the results for about 5 seconds until it has died 
away. It may occur when you start a chart with units um/s, mm/s, nm or um, or if a 
very large peak signal occurs whilst measuring floor vibration. You may also see 
sinusoidal 1/f noise with a period of 1.4 s and amplitude up to 0.2 m Pk-Pk.  
 

 
 
Extended low frequency 
 
If you need to chart low frequency magnetic fields and only an SC11/AC sensor is 
available, it is possible to extend the lower bandwidth in Waveform mode down to 
0.1 Hz. If you set lower bandwidth below 1 Hz, the Chart Recorder applies a 
digital filter to the magnetic field channels, boosting the gain below 1 Hz to 
compensate for the low frequency cut-off point of the sensor. 
 
There is a trade-off for the extra bandwidth. The digital filter is very sensitive to 
any offset voltages from the sensor amplifiers and the ADC. These cause an initial 
transient lasting up to 10 seconds. The filter also boosts the 1/f noise of the sensor, 
which causes the DC level of the trace to drift slowly up and down. When the 
lower bandwidth is set to 0.1 Hz, there is typically 0.15 mG Pk-Pk of 1/f noise at 
0.1 Hz. 
 
Chart RMS and Pk-Pk modes 
 
These modes are useful for charting the variation of AC magnetic fields, vibrations 
or sound levels over a period of time.  
 
The RMS mode charts the Root Mean Square and the Pk-Pk mode charts the Peak 
to Peak value of the signals on display. RMS mode uses high-pass and low-pass 
filters to select the bandwidth of interest followed by a function that squares, low-
pass filters and square-roots the signal to obtain the RMS. Pk-Pk mode uses an 
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algorithm that finds the peaks and valleys of the signal over a rolling period of 
time. 
 
At frequencies just below the minimum bandwidth, there is some unavoidable 
breakthrough of a rectified version of the signal. For smooth results, it is therefore 
best to set the lower bandwidth to a frequency where there is little activity. 
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Chapter 7 – Data Logging Controls 
 
 

 Data Logging <F6> 
 
Click the Data Logging tool or select Data Logging from the File menu to open 
the Data Logging control panel. 
 

 
 
The SC28 provides two types of data logging files Chart and Spectrum. Each 
have their own folder, file name and file interval settings. In addition, the SC28 can 
automatically delete old log files to save disc space. 
 
File names can embed date and time information so that they are unique and can 
show the time period that they cover. The following date/time codes are available: 
 

Code Description 
%sS Start seconds (00-59) 
%sM Start minutes (00-59) 
%sH Start hour on 24-hour clock (00-23) 
%sd Start day (01-31) 
%sm Start month (01-12) 
%sy Start year (four digits) 
%fS Finish seconds (00-59) 
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%fM Finish minutes (00-59) 
%fH Finish hour on 24-hour clock (00-23) 
%fd Finish day (01-31) 
%fm Finish month (01-12) 
%fy Finish year (four digits) 
%zM Time zone minutes (00|30) 
%zH Time zone hour (+|-)(00-12) 

 
Start and Finish refer to the start and finish times of the data in the file. All date 
and time information, including the time zone, is derived from the PC running the 
SC28 program. 
 
The SC28 starts a new file at the file interval that you set. The following are 
available: 
 

Unit Ranges 
min minute 1, 2, 3, 4, 5, 6, 10, 12, 15, 20, 30 
hour hour 1, 2, 3, 4, 5, 6, 8, 12 
day Day (24 hours) 1, 2, 3, 4, 5, 6, 7 

 
Each file starts on a whole multiple of its file interval. The available lengths are 
designed so that whole multiples of the file interval always fit into the next unit 
above. Therefore, files with lengths set in minutes always fit neatly into each hour 
and files with lengths set in hours always fit neatly into each day. 
 
When you start the SC28, or after you change the file interval, the SC28 waits until 
the next whole interval is reached before it starts logging. While in this state, data 
on the Charts start part way through the interval. 
 
When Chart Logging is enabled, the SC28 includes a point for each signal on 
display for each Chart Time Step during the file interval.  
 
When Spectrum Logging is enabled, the SC28 combines spectra during the file 
interval and writes the resulting spectrum to the file for each signal on display. 
 
If Delete Files After is enabled, whenever the SC28 creates a new log file, it 
checks the folder to see if any files are older than the limit set and deletes them. 
The Chart and Spectrum folders are handled separately. If logging is not enabled 
for a folder, files are not deleted from it. 
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Chapter 8 – Environmental Specifications 
 
Specifications 
 

You can use the Specifications feature to quickly check whether a particular site 
meets the environmental specifications of an electron beam instrument or other 
equipment. You can load in specification files to show on the Spectrum display for 
direct comparison with your measured results. You may load more than one 
specification file at a time. The specification is normally shown as a thick grey 
line, but if the Selected spectrum at any point exceeds the specification, then the 
specification is displayed as thick magenta line. 
 

 Specifications <F9> 
 

 
 
The Select Specification panel lists the specification files that you have loaded. 
 

 Add 

 Remove 
Use the Add tool to add a file and the Remove tool to remove the selected file 
from the list.  
 

 New 

 Edit 
Use the New tool to create a new file and the Edit tool to edit the selected file.  
These tools both open the Specification Editor. See below for details. When you 
close the Specification Editor, you return to the Select Specifications panel. If you 
did not change the name of the file, it will be automatically updated. If you create 
or rename files, then you have to load them explicitly. 
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If the sensor or channel of the selected signal matches the specification file, then a 
tick  appears by the filename and the specification is displayed on the spectrum.  
If they do not match, the forbidden symbol Ø appears by the filename. The 
specification remains on the list, but is not displayed until you select a signal with 
the same sensor and channel as in the file. 
 
When the Spectrum Analyser displays the specification, it takes into account the 
units, Spectrum Mode and linear or logarithmic scales. For example, if you display 
a specification in nT RMS alongside measurements in mG Pk-Pk, then the program 
converts the specification into mG Pk-Pk for direct comparison. If you use 
different choices for log or linear scales, then straight lines on the specification 
may appear curved. Therefore, to avoid confusion, it is best to use the same units 
and scales for your measurements as the specification. 
 
When the Spectrum Analyser exports or data logs results, it also outputs the 
specifications that are on display. When you save a Spectrum Analyser setup file, it 
contains references to any specification files that are loaded. These specification 
files are re-loaded when you re-open that setup file. 
 

Specification Editor 
 
You can use the Specification Editor to create and edit specification files. See 
above for how to open the Specification Editor.  
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Specification Editor menus 
 
File 
 New Create a new specification file 
 Open Open an existing specification file 
 Import Spectrum Import a Spectrum Analyser results file  
  as a specification 
 Save Save the current file 
 Save As Save the file with a different name 
Edit 
 Check Table Display any errors found in the data 
Help 
 Show Context Help <Ctrl+H> Open the Help window 
 Help on Edit Specification Open the Help file 
 
Once within the Specification Editor, you can use the File menu to start a New file, 
Open an existing file or Save the current specification to a file. You can also 
Import one channel’s spectrum from a result file. This enables you to compare the 
current spectra with previously saved ones. 
 
You can add a Comment that will appear on the Specifications panel when the file 
is loaded. Typically the comment identifies the instrument that the specification 
belongs to, and gives the direction of the measurement and whether it is magnetic 
field, vibration or sound level. 
 
When you have selected the Sensor, you can then select from the Amplitude 
Units available for that sensor. Select a Mode (RMS, 0-Pk or Pk-Pk) and tick the 
Channels that this specification works with (the default is all channels). 
 
The Specification Editor does not allow you to select acoustic units dBA or dBC, 
because the Spectrum Analyser does not convert the dB weighting of 
specifications. Use dB and ensure the correct weighting is used for measurements. 
When dB is selected the Mode is always RMS. 
 
Enter the data points of the specification into the table. Click the right mouse 
button on the table to show the pop-up menu that contains some options to help 
you to edit the table. Put the frequency in Hz in the left column. Put the amplitude 
in the units shown in the right column. Frequency values must be greater than or 
equal to zero and increase as you move down the table. Amplitude values for all 
except dB units must be greater than zero. You can check the data in the table 
using Check Table on the Edit menu. If there are errors, a window appears, listing 
the errors. If there are no errors, nothing happens. You cannot save a specification 
that has errors. 
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The program interpolates straight lines between your frequency points, so you only 
need to enter the turning points of the specification. If the specification has a step 
change in level, then repeat the frequency value at that point and enter different 
amplitude values in the two cells in the right column. There is no need to enter 
values for frequencies outside the range of the specification. 
 
Set the Frequency Mapping and Amplitude Mapping to Log or Lin (logarithmic 
or linear). The program uses this information to interpolate lines between the 
points you enter. When the scales on the Spectrum Analyser match the settings 
here the interpolated lines are straight. If you see curved lines, then either the 
settings here are wrong, or you are viewing the data with different log/lin settings 
or different displacement/velocity/acceleration units from the original 
specification. The vertical mapping for dB units is always linear. 
 
The Specification file format is shown in Appendix 2 - File Formats. 
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Chapter 9 – SC28 Calibration 
 
 
Calibration Panel 
 

 Calibration <F2> 
 

 
 
On the Sensors tab of the Calibration panel, you can select the sensors you are 
using.  
 
All Spicer Consulting sensors and interfaces are identified by their serial numbers. 
Other sensors are identified by their manufacturer, type and serial number. 
SC28/SI units set the serial number automatically. 
 
On the SC128/SI, there are three Vibration sensors. The acoustic sensor is a 
precision microphone. The Temp / RH sensor is an SC28/TH. 
 
Reset DC Sensor 
 
The Reset DC Sensor button is available on the Sensors tab only when a DC 
sensor is connected to the SC28/SI. If you move a DC sensor, you must reset it by 
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clicking either this button or the Reset DC button in the tool bar of the SC28 
Monitor. The following window appears:  
 

 
 
Initially the DC sensor outputs are zero, while it internally zeros its output to the 
nearest 1 mG at the current X, Y and Z magnetic field levels. After that, the DC 
sensor outputs turn on and the software uses low-pass filtering to compensate for 
any residual offset. The green light comes on if the DC sensor has successfully 
reset to within ±2 mG and the window closes automatically. This process takes 
2.5s for newer “1s reset” DC sensors and 12.5 seconds for older DC sensors. 
 
If either DC sensor failed to reset properly, then its green light goes out and a 
warning dialog appears. In this case, check the red LED on the DC sensor, which 
flashes if it is too close to any permanent magnets that put the DC field out of 
range of the reset (±2 G). Also ensure that there are no deliberate field generators 
turned on that could be changing the field level at frequencies around 0.1 to 1 Hz. 
Then try again.  
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Microphone Self Check 
 
The Brüel & Kjær precision microphone has a delicate diaphragm that is biased to 
200 V in operation and requires careful handling. To check that the microphone is 
in good condition, click the Self Check box that appears when a precision 
microphone is selected. The check takes 2 seconds and gives a pass/fail result. 
The microphone self check uses Brüel & Kjær’s patented charge-injection 
calibration technique to test the microphone and the whole signal chain. To make 
the check reasonably independent of ambient sounds, the system generates a 70 Hz 
sine wave test signal and ignores all other frequencies. If the check passes, the 
microphone is working. If it fails, check that it is connected properly. 
 
Add Sensors 
 
Sensors are made available for selection in the Calibration panel by adding their 
calibration files to the SC28 system. Click the Add Sensors… button. 
 

 
 
Have Calibration Files 
 
Spicer Consulting provides calibration files for sensors on a USB memory stick. 
The calibration files are named as follows, where * represents the serial number: 
 
Sensor interface si*.cal 
3-axis magnetic field sensor sen*.cal 
Accelerometer acc*.cal 
Acoustic sensor mic*.cal 
Temperature/Humidity sensor th*.cal 
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Insert the calibration memory stick, select Have calibration files and click OK. 
The file dialog appears. Browse to the location of your calibration files, select the 
files you wish to add to the SC28 system and click OK. You can select all the files 
using <ctrl-A> (recommended), individual files using <ctrl-click> or a range of 
files using <shift-click>.  A pop-up window confirms the number of files added. 
 
Next select the sensors you are using on the Sensors tab of the Wizard. 
 
Run Uncalibrated 
 
If you do not have the calibration files, then as a last resort, you can select Run 
uncalibrated to get started. There may be some loss of accuracy for 3-axis 
magnetic field sensors, 731A accelerometers or precision microphones. However 
there is typically no loss of accuracy for Sensor Interfaces or 
Temperature/Humidity sensors, since these are independently calibrated. 
 
Select only the sensors that you need and click OK. The system adds default 
calibration files that you can select on the Sensors tab of the Calibration panel, 
SC11 Wizard or SC11 Survey. 
 

 
 
 Note: After using the default files, it is recommended that you take steps 

to obtain the correct calibration files as soon as possible. You 
should then delete the default files to avoid confusion. 
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User Defined Units 
 
Under the Units tab, you can enter user-defined units for use with the AUX input 
(or the MAG or MIC input of the Sensor Interface). For example, you might 
connect a Spicer Consulting SC22 Magnetic Field Cancelling System BNC output 
to the AUX input. The SC22 measures magnetic field and outputs 1.0 Volts per 
milliGauss with 10 kΩ output impedance. The input impedance of the AUX input 
is 100 kΩ, so the result is that a 1mG field produces a voltage of 1.0 * 100/110 V = 
0.909 V. 
 

 
 
To add a unit for this situation, you would enter its details into a row of the table: 
· Name of the unit – in this case, mG the abbreviation for milliGauss. 
· Size of the unit in Volts – in this case 0.909 
· Name of the sensor – in this case SC22 
· Comment identifying the signal source. 
There is a special case for user sound level meters. If the name of the unit is dB, 
then the size of the unit is in Pa. dB user defined units appear only in the Spectrum 
Analyser and Chart Recorder. See Appendix 3 – Units for more information about 
sound level units. 
 
The sensor name for a user unit may not be the same as any of the built-in sensors: 
Magnetic, Vibration, Acoustic, Voltage, Temperature or Humidity. 
 
To delete a unit, delete all characters in both the Name and the Size. Any blank 
lines you leave in the table are ignored. 
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When you have defined units, the sensor names are added to all Sensor controls 
that list the Voltage sensor. It is possible to use the AUX or MAG inputs. In the 
software, select the sensor and unit you have defined. 
 
The program displays and data logs the signal in the selected unit by dividing the 
input voltage by the size of the unit. 
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Chapter 10 - Menu and Toolbar Functions 
 
Menu 

 
This section lists all the menu functions of the Oscilloscope, Spectrum Analyser 
and Chart Recorder. Their operation is described in the following sections. 
 
File  
 Calibrate… Open the Calibration panel. 
 Specifications… Open the Specification panel. 
 Open Setup… Load control settings from a file. 
 Save Setup… Save control settings to a file. 
 Data Logging… Open the Data Logging panel. 
 Exit <Ctrl+Q> Exit the program. 
Window  
 Full Size <Ctrl+/> Maximise the instrument window to fill the 

screen or restore the window to its previous 
size. See Resizing the Window, below. 

Help  
 Show Context Help <Ctrl+H> Show the help window. 
 Help for SC28 Show the SC28 help file. 
 About… Show brief information about the program. 

 
Calibration Tool 

 

 Calibration <F2> 
 
Calibration is described in Chapter 9, SC28 Calibration. 

 
Specification Tool 

 

 Specifications <F9> 
 
Specifications are described in Chapter 8, Environmental Specifications. 

 
Setup Files 

 

 Open Setup <F3> 

 Save Setup <F4> 
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A setup file saves all the control settings including data logging. The default setup 
file setup.sc28 is loaded automatically when the program starts. You can also 
save and load named setup files using the Open and Save tools or Open Setup… 
and Save Setup… from the File menu. 

 
Data Logging Tool 
 

 Data Logging <F6> 
 

This opens a dialog to set the Data Logging controls. For details see Chapter 7 – 
Data Logging Controls 
 

Exiting the Program 
 
You can exit the Monitor window using the X button at the top right of the window 
or using Exit from the File menu. The menu option also asks if you want to replace 
the default file. See Setup Files above. 
 

Resizing the Window 
 
You can re-size the window of the SC28 Monitor by dragging the edges or corners, 
by clicking on the Maximise button near the top right or by using Full Size on the 
Window menu. The graph areas expand to give a more detailed view of your 
results. It remembers the size and position that was last used.  

 
Help Tool 

 

 Help <F1> 
 
The Help tool opens the sc11 help file at the page relevant to the current panel. 

 
Reset DC Sensor Tool 

 

 Reset DC Sensor <F8> 
 
This tool is available only when one or two DC sensors are connected to the 
SC11/SI. It resets the DC sensor(s) and calibrates their offsets. This function is also 
available on the Sensors tab of the Calibration panel. See above for details. 
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Autoscaling 
 

 Autoscale X 

 Autoscale Y 

 Reset scale 
 
Autoscale X and Autoscale Y scale the plot to fit all the data in the horizontal and 
vertical directions respectively. Reset scale resets the plot to the values set on the 
control panel scales. 

 
Plot Tools 

 

 Zoom X 

 Zoom Y 

 Zoom Area 

 Pan 
 
Zoom X, Zoom Y and Zoom Area select different ways of zooming in by 
dragging the mouse over the plot. Pan allows you to drag the data around the plot 
area. 
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Appendix 1 – SC28 Specification 
 

System 
Box Size 58 x 36 x 19  cm approx. (23 x 14 x 7.5 in approx.) 
Weight 11 kg (24 lb) approx. 

Personal Computer Requirements 
Operating System Windows 7/8.1/10 
Display At least 1280 x 960 pixels 
Ethernet Interface At least 100 Mbps 
Processor As required for operating system.  
Memory As required for operating system. 
Hard Disc As required for operating system. 

Data Acquisition 
Resolution/Range Bits Input Range Resolution 
  13 ±10V 2.44 mV 

Core System: SC28/SI - Sensor Interface (Ethernet-based) 
Inputs 
 MAG 3-axis magnetic field sensor 
 VIBX, VIBY, VIBZ 3-axis vibration (3 x Wilcoxon 731A) 
 MIC Microphone (B&K 4190/2669L) 
 AUX BNC voltage input, DC coupled, ±10 V range, 100 k input impedance. 
 TEMP/RH SC28/TH Temperature/Humidity Sensor 
Anti-aliasing Filters 20kHz 
Sampling rate 200 kHz x 8 channels + 1 Hz x 2 channels continuous 
Data transfer rate 2 kHz x 8 channels + 1 Hz x 2 channels continuous 
Power 9-36V DC, 12 W max 

3-axis AC Magnetic Field Sensor: SC11/AC 
Co-ordinate System X, Y, Z rectangular Cartesian 
Bandwidth 1 - 20 kHz 
Dynamic Range 80 mG (8  Pk-Pk 
Noise Limit 3G RMS max 
Accuracy ±1 %  

3-axis DC Magnetic Field Sensor: SC24/DC+AC 
Co-ordinate System X, Y, Z rectangular Cartesian 
Bandwidth DC - 10 kHz 
Ambient Field Range ±2 G (±200 uT) 
Dynamic Range ±20 mG (±2 Pk-Pk 
Noise Limit DC: 5 G (0.5 nT) Pk-Pk typ. (0.0001 – 0.01 Hz) 
  AC: 0.1 G/Hz (10 pT/Hz) RMS typ. at 50 Hz 
Accuracy ±1 % (after >2hour warm up). (±15 % cold) 

Vibration Sensor: Wilcoxon 731A Accelerometer 
Type Wilcoxon Research, model 731A 
Bandwidth 0.1 - 500 Hz 
Dynamic Range 2 m/s2 (0.2 g’s*) Pk-Pk (in this system) 
Noise Limit 7 m/s2 RMS max. 
  0.35 m/s RMS at 1Hz, 0.11 m/s RMS at 5Hz 
  0.07 m RMS at 1Hz, 0.0035 m RMS at 5Hz 
Accuracy ±5 % (with gain calibration file) 
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Acoustic Sensor: B&K 4190/2669L Precision Microphone 
Type Brüel & Kjær, Condenser microphone 4190, Pre-amplifier 2669L  
Bandwidth 1.5 Hz - 20 kHz 
Dynamic Range 110 dB (in this system) 
Noise Limit 20 dB (in this system) 
Accuracy ±1 dB 3 Hz - 20 kHz 

Temperature/Humidity Sensor: SC28/TH 
Sample rate 1 Hz max 
Performance Temperature Relative Humidity 
 Dynamic Range  0 - 100 °C  0 - 100 %RH   
 Resolution 0.01 °C  0.01 %RH 
 Accuracy ±0.2 °C  ±2 %RH 
 Drift (max) 0.03 °C/Year 0.25 %RH/Year 

Software 
Channels 10: MX, MY, MZ, VX, VY, VZ, A, U, T, H 
Clipping Visual indication  
Display modes Scope, Spectrum, Chart (simultaneous) 
Selection Individual Channels, Display modes 
Scales 6: Magnetic, Vibration, Acoustic, User-defined, Temperature, Humidity 
Amplitude units 
 Magnetic field mG, nT, uT, mA/m, A/m 
 Vibration g’sα, mg'sα, m/s2, mm/s2, m/s, mm/s, nm, m 
 Acoustic mPa, Pa, dB 
 User-defined mV, V, user defined units 
 Temperature °C, °F 
 Humidity %RH 
Amplitude ranges   
 General 1, 2, 5, 10, 20, 50, 100, 200, 500 
 dB 50, 60, 70, 80, 90, 100, 110, 120 
 °C, %RH 30, 40, 50, 60, 70, 80, 90, 100 
 °F 60, 80, 100, 120, 140, 160, 180, 200 
Spectrum Analyser 
 Frequency ranges 25, 50, 100, 250, 500, 1000 Hz full scale. 
 Number of points 250, 500, 1000, 2000, 4000 
 Accuracy Frequency: ±0.01% ±0.02 div 
 Waveform windows None, Hanning, Flat top 
 Spectrum modes RMS, 0-Pk, Pk-Pk, PSD, Third Octave (RMS, 0-Pk, Pk-Pk) 
 Combine spectra Average/Peak 
 Specification files Create, edit, add & remove. Compare with measurements. 
Chart Recorder 
 Time step 1, 2, 3, 4, 5, 6, 10, 12, 15, 20, 30 s/point 
  1, 2, 3, 4, 5, 6, 10, 12, 15, 20, 30 min/point 
 Chart modes Waveform, RMS, Peak to Peak, 
 Bandwidth controls Lower and Upper - individual for each scale 
Data Logging 
 Logging Chart Logging, Spectrum Logging, Folder, Filename, File interval 
 Deletion File age 
Calibration panel Add/select sensors, reset DC sensor, microphone self check, add/edit user 

defined units. 
Setup file Open/save control settings 
Help Context help on controls, online help file 
α g’s are units of the acceleration due to gravity 
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Appendix 2 - File Formats 
 

Export File Text Format 
 
[Header] 
Version="Version" 
Program="Program" 
Mode="FileMode" 
Date="Date" 
Time="Time" 
Setup="SetupFile" 
Title="GraphTitle" 
Sensors=NumSensors 
for (i=0; i<NumSensors; i++){ 
Sensorsi="Channel=Channel,Sensor=SensorType,BWlower=BWlower, 

BWupper=BWupper,Name=SensorName"} 
Controls=NumControls 
ProgControls 
Stats="ProgStats" 
Axes=NumAxes 
for (i=0; i<NumAxes; i++){ 
Axesi="Name=AxisName,Min=Min,Max=Max,Major=Major, 

Minor=Minor,Format=Format,Precision=Precision, 
Map=AxisMap"} 

Markers=NumMarkers 
for (i=0; i<NumMarkers; i++){ 
Markeri="Time=MarkerTime,Text=MarkerText"} 
Cursors=NumCursors 
for (i=0; i<NumCursors; i++){ 
Cursori="Name=CursorName,X=X,Y=Y,Signal=CursorSignal"} 
Horiz="Name=HorizName,Unit=HorizUnit,Map=HorizMap,Start=Start, 

Step=Step,Points=NumPoints" 
Signals=NumSignals 
for (i=0; i<NumSignals; i++){ 
Signalsi="Name=SigName,Unit=SigUnit,Range=SigRange,Display=SigDisplay, 

Position=SigPosition,Axis=SigAxis"} 
[Data] 
H0  S0,0 .. SNumSignals,0 
:  : : : 
Hnp  S0,NumPoints-1 .. SNumSignals-1,NumPoints-1 

[End] 
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Normal type appears in the file. C-style for loops make repeated lines. Data values 
are separated by tabs. Italics are substituted as follows: 
 
Version Current version of SC28 
Program Program that created the file (SC28) 
FileMode How the file was output (Logged) 
Date & Time Date and time data logging started 
SetupFile Name of program setup file (setup.sc28) 
Title Graph title (SC28 Chart, SC28 Spectrum) 
NumSensors Number of sensors 
Channel Sensor channel (MX, MY, MZ, VX, VY, VZ, A, U, T, H) 
SensorType Sensor type (Magnetic, Vibration, Acoustic, Voltage, User-defined, 

Temperature, Humidity) 
BWlower Sensor lower bandwidth  
BWupper Sensor upper bandwidth  
SensorName Sensor name (eg. SC24/DC Sensor S/N 12345) 
NumControls Number of program-specific control setting lines (see below) 
ProgControls Program-specific control settings (see below) 
ProgStats Program-specific statistics (see below) 
NumAxes Number of axes 
AxisName Axis name (eg. Frequency (Hz)) 
Min & Max Axis minimum and maximum 
Major Axis major tick size 
Minor Axis minor tick size 
Format Axis format (Dec, Sci) 
Precision Axis precision (0 .. 6) 
AxisMap Axis mapping mode (Lin, Log) 
NumMarkers Number of markers 
MarkerTime Marker time 
MarkerText Marker text 
NumCursors Number of cursors 
CursorName Cursor name 
X & Y Cursor X & Y position 
CursorSignal Signal cursor is attached to 
HorizName Horizontal axis name (eg. Frequency) 
HorizUnit Horizontal axis unit (eg. Hz) 
HorizMap Horizontal axis mapping mode (Lin, Log) 
Start Horizontal start point 
Step Horizontal step between points (add for Lin, multiply for Log) 
NumPoints Number of points 
NumSignals Number of signals 
SigName Signal name (eg. VX) 
SigUnit Signal unit (eg. um/s2 RMS) 
SigRange Range control associated with signal 
SigDisplay 1=Show signal, 0=Hide signal 
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SigPosition Signal position 
SigAxis Axis signal assigned to (1 .. 4) 
Only displayed signals are output to the file.   
 
The program-specific ProgControls and ProgStats are as follows: 
 
Spectrum Analyser 
 
Controls0="NumPoints=NumPoints,Resolution=Resolution,Window=Window, 

Mode=SpecMode,CombineMode=CombMode, 
MaxSpectra=MaxSpectra" 

Stats="Combined=NumComb, MXclip=MXclip,MYclip=MYclip,MZclip=MZclip, 
VXclip=VXclip,VYclip=VYclip,VZclip=VZclip,Aclip=Aclip,Uclip=Uclip" 

 
Italics are substituted as follows: 
 
NumPoints Number of points in spectrum  
Resolution ADC resolution (Fine, Coarse) 
Window Window function (None, Hanning, Flat Top) 
SpecMode Spectrum mode (Spectrum RMS, Spectrum 0-Pk, Spectrum Pk-Pk, 

PSD, Third Octave RMS, Third Octave 0-Pk,  
Third Octave Pk-Pk) 

CombMode Combine mode (Average, Peak) 
MaxSpectra Maximum number of spectra to combine 
NumComb Number of spectra combined 
MXclip..Aclip Clipping indicators for all channels (0=not clipping, 1=clipping) 
 
The Spectrum Analyser adds signals for displayed specifications, named Speci, 
where i goes from 0 to NumSpecs-1. Data values are set to NaN for frequencies 
outside the range of the specification. 



© Spicer Consulting, 2020  SC28 User Manual 51 

Chart Recorder 
 
Controls0..5="Scale=Scale,Mode=ScaleMode,BWlower=BWlower, 
  BWupper=BWupper" 
Stats="MXclip=MXclip,MYclip=MYclip,MZclip=MZclip,VXclip=VXclip, 
 VYclip=VYclip,VZclip=VZclip,Aclip=Aclip,Uclip=Uclip,Tclip=Tclip, 
 Hclip=Hclip" 
 
C-style for loops and if statements make repeated and alternative lines. Italics are 
substituted as follows: 
 
Scale Scale (MX, MY, MZ, VX, VY, VZ, A, U, T, H) 
ScaleMode Scale mode (Waveform, RMS, Pk-Pk) 
BWlower Scale lower bandwidth 
BWupper Scale upper bandwidth 
MXclip..Hclip Clipping indicators for all channels (0=not clipping, 1=clipping) 
 
The SC28 Chart Datalog may format the horizontal signal data H0 to Hnp as an 
ISO 8601 compliant time stamp of the form: yyyy-mm-ddTHH:MM:SS+/-ZZ:zz 
where: 
Yyyy-mm-dd Date with 4-digit year, 2-digit month and 2-digit day of month 
HH:MM:SS Time on 24-hour clock, with 2-digit hour, minute and seconds 
+/-ZZ:zz Time zone difference from GMT with either + or – and 2-digit hour 

and minute. 
Other programs use a floating-point number. 
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Specification File Format 
 
Version version 
comment 
Sensor sensor 
freqscale ampscale 
frequnit ampunit mode 
f0 S0 
: : 
fn-1 Sn-1 

 
All fields are separated by tabs. Words in italics are substituted as follows: 
 
version the version of the program that created the file 
comment comment describing the specification 
sensor  sensor type (Magnetic, Vibration, Acoustic, Voltage) 
freqscale frequency scale of the specification (lin, log) 
ampscale amplitude scale of the specification (lin, log) 
frequnit frequency unit of the specification (always Hz) 
ampunit amplitude unit of the specification 
mode  mode of amplitude unit (RMS, 0-Pk, Pk-Pk) 
f0 & fn-1 first and last frequency values 
S0 & Sn-1 first and last amplitude values 
 

Default Folders 
 
By default, all executables, dynamic link libraries and originals of default setup 
files for SC28 1.0 are installed in one of the following folders. These files should 
not be altered. 
 
 C:\Program Files\Spicer Consulting\SC28 1.0 (32-bit Windows) 
 C:\Program Files (x86)\Spicer Consulting\SC28 1.0 (64-bit Windows) 
 
By default, all calibration files, setup files and specification files for SC28 1.0 are 
stored in the following folder. These files are created and modified by the SC11 
programs. 
 
 C:\Users\user\AppData\Local\Spicer Consulting\SC28 1.0 
 
Where user is the username of the user running the SC28 program. 
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Appendix 3 - Units 
 

This appendix gives some general information about the units used in the SC28 
software. 
 

Magnetic Field Units 
 
The SI unit for magnetic flux density, B is T (Tesla).  
1 T is a strong magnetic field. The older unit G (Gauss) is often used.1 G = 10-4 T. 
mG (milliGauss), µT (microTesla) and nT (nanoTesla) are used for typical 
environmental fields. 
 
The SI unit for magnetic field strength, H is A/m (Amp/metre).  
In free space, 1 A/m = 4  10-7 T. 
Oe (Oersted) is sometimes used for magnetic field strength. 
1 Oe = 1/4 kA/m. In free space, 1 Oe = 1 G.  
A/m and Oe are not often used for environmental field measurements. 
 
The following table gives some conversions derived from the above: 
 

Gauss Tesla A/m 
1 G 100 T 79.6 A/m 
100 mG 10 T 7.96 A/m 
12.6 mG 1.26 T 1 A/m 
10 mG 1 T 0.796 A/m 
1 mG 100 nT 79.6 mA/m 
0.1 mG 10 nT 7.96 mA/m 
12.6 G 1.26 nT 1 mA/m 
10 G 1 nT 0.796 mA/m 
1 G 100 pT 79.6 A/m 
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Vibration Units 
 
Vibration may be measured in displacement, velocity or acceleration units. The SI 
units for these quantities are m (metre), m/s (metre per second) and m/s2 (metre per 
second squared) respectively. g’s (the acceleration due to gravity) are also used. 
The acceleration due to gravity varies from place to place, but for the purpose of 
defining the units, 1 g’s = 9.80665 m/s2. 
 
µm (micron), µm/s (micron per second), mm/s2 (millimetre per second squared) 
and µg’s (microgees) are suitable for environmental measurements. There are 
various standards for vibration measurements, but no industry-wide agreement 
over which standards to use. 
 
Displacement, velocity and acceleration are related by integration. 
 

 
 
Integration and differentiation are straightforward in the frequency domain. For 
example, the velocity spectrum is simply the acceleration spectrum divided by  
and the displacement spectrum is the acceleration spectrum divided by where 
 = 2f and f is the frequency.  
 
The following table gives some conversions between vibration units at different 
frequencies. 
 

Frequency Displacement Velocity Acceleration 
Hz µm µm/s µm/s2 µg’s 
0.159 1 1 1 0.102 
1 0.159 1 6.28 0.641 
1.59 0.1 1 10 1.02 
10 0.0159 1 62.8 6.41 
15.9 0.01 1 100 10.2 
100 0.00159 1 628 64.1 
159 0.001 1 1000 102 
1000 0.000159 1 6280 641 
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Sound Level Units 
 
The Sound Pressure Level (SPL) in dB (deciBel) is referenced to the softest pure 
tone audible to normal human ears at 1 kHz. This is an intensity of 10-12 W/m2, 
which in air at 20 °C is a pressure, P0 = 20 Pa (microPascal) RMS. The sound 
pressure level in dB is given by: 
 
  SPL = 20 log10(P/P0) 
 
Two commonly used frequency weightings are:  
 

dBA This has reduced sensitivity to low frequencies and is tailored for 
measuring the effect of the sound on the human ear. 
 
dBC This has a much flatter response and is suitable for measuring the 
effect on equipment. 

 
The following table shows some example levels for the Radio Shack analogue 
sound level meters. 
 

Range (dB) Meter Reading SPL (dB) Pressure (Pa RMS) 
70 0 70 0.063 
80 -6 74 0.1 
80 0 80 0.2 
80 +6 86 0.4 
90 0 90 0.63 
90 +4 94 1.0 
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Appendix 4 - Window Functions 
 

The windows apply the following transformations to the waveform: 
 
Hanning yi = a0 xi [ 1 - cos(2i / n)] i = 0, 1, 2, ..., n-1 
 
Flat Top yi = b0 xi [ 1 - b1 cos(2i / n) + b2 cos(4i / n) 
           - b3 cos(6i / n) + b4 cos(8i / n)]  i = 0, 1, 2, ..., n-1 
 
where  xi is the ith point of the original waveform 
  yi is the ith point of the transformed waveform 
 n is the number of points in the waveform 
 a0 is 0.5 
 b0 is 0.215578948 
 b1 is 1.932617187 
 b2 is 1.286132809 
 b3 is 0.38769531 
 b4 is 0.03222656 
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temperature, 14 
temperature sensor, 9 
third octave, 16 
toolbar, 43 
units, 53 
units, user defined, 41 
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